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SUMMARY 

 

Some of the radionuclides, that had been released to the atmosphere from the 

Fukushima Dai-ichi Nuclear Power Plant (FDNPP) accident, were transported to the 

Korean territory and began to be detected on March 28, 2011 at some regional 

environmental monitoring stations of Korea and continued to be detected until May 

31, 2011 (Kim et al., 2012). The radioactivity of 131I, 134Cs and 137Cs in aerosols and 

rainwater reached peak values on April 6, 2011 at the Jeju monitoring station which 

is located in the northern region of Jeju Island. Jeju Island is the largest island of 

Korea located about 100 km distant in southwest direction from the southern end of 

the Koran peninsula. Radionuclides of the highly volatile elements I and Cs are 

released into the atmosphere in early stages of a nuclear reactor core melt-down 

accident and carried away long distance from the accident place, and thus they have 

been frequently used for tracing and evaluating the radiological impact from an 

nuclear power plant accident or an open air nuclear bomb test by which a large 

amount of radioactive fission products is released to the atmosphere (Aoyama et al., 

1987, Molero et al., 1999, Pittauerova et al., 2011, Tagami et al., 2011). 131I has a 

very short half-life (≈ 8 d) and thus it can be traced only for a short period of time 

after an accident. The half-life of 134Cs is about 2 years so that it can be traced for 

several years after an accident. The half-life of 137Cs is long enough (≈ 30 a) to be 

traced for several tens of years. Tremendous amounts of 137 Cs were released into the 

atmosphere by open air nuclear bomb tests conducted during 50’s and 60’s and by 

the Chernobyl nuclear disaster occurred in 1986. Since the released 137Cs had spread 
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out over the world and deposited on the ground, the most surface soils in the world 

generally have substantial inventory of 137Cs. Lee et al. (1998) reported the 

distribution of 137Cs in soils of many regions of Koran peninsula except for Jeju 

Island. As the time passes after the accident, radionuclides with short half-lives such 

as 131I are no longer measurable above minimum detectable limit (MDA). Instead 

134Cs and 137Cs have become prime radionuclides used for assessing the radiological 

consequences of the Fukushima accident. Since both nuclides are chemically 

identical, the radioactivity ratio of 134Cs and 137Cs depends on the burnup of the 

damaged nuclear fuel. Hence it is specific to a particular accident and remains 

unchained if decay correction is properly made. The initial radioactivity ratio was 0.5 

to 0.6 during the Chernobyl accident, and it was about 1.0 for the Fukushima 

accident. 

No attempt has been yet made to assess the radiological impact on the soil of Jeju 

Island from the FDNPP accident. About 7 months after the accident, we have 

selected 12 locations in Jeju Island and collected at each location a sample of surface 

soil and mosses growing on nearby stones and rocks. We measure specific activities 

of 134Cs and 137Cs in the surface soil and moss samples by gamma-ray spectrometry 

and estimate the amount of 137Cs in the soil originating from FDNPP accident. 

Activity profiles of 134Cs and 137Cs are obtained for a cored soil sample to see the 

migration behavior of both nuclides.  

Specific activities of 134Cs and 137Cs in the surface soil vary from less than MDA 

to 17 Bq/kg and from 12 Bq/kg to 109 Bq/kg, respectively. Specific activities of 

134Cs and 137Cs in moss samples lie in the range 6 Bq/kg to 39 Bq/kg and 15 Bq/kg to 

41 Bq/kg, respectively. The activity ratios 134Cs/137Cs in the soil samples are much 
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less than the reference value of about 1.0, but they are close to 1.0 in the moss 

samples. Average amount of 137Cs added to the surface soil after the Fukushima 

accident is estimated to be 7.8 ± 1.7 Bq/kg. The depth profile of 137Cs specific 

activity has a lognormal shape with a peak between 5 cm and 7.5 cm below the 

ground. For the cored soil sample, 134Cs was detected up to 3 cm below the ground. 
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I. 서  론 

 

원자력발전소의 가동과 연구기관, 의료기관 및 산업체 등에서 방사성 물질의 

사용 증가에 따라 자연 환경의 방사성 오염 가능성이 증대되고 있다. 특히 1979

년 미국에서 일어난 TMI 원자력 발전소 사고와 1986년 4월 26일 구 소련 체르노

빌 원자력 발전소 사고로 인하여 방사성핵종이 대기 중으로 확산되어 이동한 후, 

대기 중에 부유하거나 지표면에 침착하였다. 또한 2011년 3월 11일 규모 9.0의 

대지진이 발생하였고, 이어 10미터가 넘는 쓰나미가 동북부 일본 해안을 강타하

여 후쿠시마 원자력발전소의 1,3,4호기 건물이 손상되었고, 이로 인하여 핵반응 

생성물이 외부로 방출되기 시작하여 미국이나 유럽 및 세계 각국으로 퍼져나갔

다. 실제로 한국원자력안전기술원(KINS: Korea Institute of Nuclear Safety)에서 

실시한 환경방사능 측정 결과를 보면 국내에서는 2011년 3월 24일부터 춘천에

서 측정되기 시작했으며, 4월 5일부터 국내 전 지역에서 측정되었다. 이렇듯 환

경 중에는 이미 인공방사성핵종이 존재하고 있으며, 세계 여러 나라에서 환경방

사선에 대한 연구뿐만 아니라 방사능 오염사고의 가능성에 대비하여 자국의 방

사능 오염사고는 물론 인접국의 사고로 인한 자국의 방사능 오염에 대비하는 감

시체계를 운영하고 있으며, 국내의 경우에 감시망 운영은 중앙 방사능측정소인 

KINS을 중심으로 인구 밀접지역 및 지역적 안배 등을 고려한 12개소 지역(서울, 

부산, 대구, 대전, 광주, 춘천, 군산, 제주, 강릉, 안동, 수원, 청주)에 설치된 지방

측정소와 울릉도 및 백령도 등에 설치된 25개 간이측정소의 전산화를 통한 중앙

집중식으로 관리하고 있다.   

한편, 일반적으로 환경토양에서 발견되는 세슘동위원소는 핵분열생성 시 그 생

성 및 방출비가 다른 인공핵종들보다 높기 때문에 환경방사능 감시에 주요 목적 
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핵종으로 취급되고 있다. 그리고 137Cs은 포타슘과 화학적 성질이 비슷하여 인체

로 쉽게 이동되는데 특히 생식선(gonad)에 쉽게 침적된다. 또한 134Cs는 베타 붕

괴하여 604.72 keV의 특성감마선을 방사하고 안정한 134Ba이 된다.  이는 많은 양

이 인체에 들어오면 불임증, 전신마비, 백내장, 갑상선암, 골수암 등을 유발할 수 

있다. 이렇게 원전사고 시 방출되는 대표적 핵종으로 볼 수 있는 134Cs 및 137Cs은 

토양에 흡착이 잘되며, 측정이 용이한 감마선을 방출하고, 시료 전처리가 비교적 

간단한 편이어서 본 연구에 목적 핵종으로 정하였다. 특히 토양에 침착하여 잘 

움직이지 않기 때문에 10년 이상까지도 측정이 가능하다. 그러므로 환경 중에서 

측정된 세슘의 비와 후쿠시마 원전사고 당시 방출된 세슘의 비를 비교하여 현재 

존재하는 환경 중 세슘의 기원을 확인할 수 있다.  

또한 토양에 대한 방사성 핵종 흡착도는 방사성 핵종농도 및 산화상태, 토양의 

pH 및 유기 혹은 무기 리간드 함량에 의존할 뿐만 아니라 강우량, 토양의 종류 

및 식물 등의 지역적 특성에도 의존한다.  이렇게 변수가 많지만 토양은 쉽게 구

할 수 있고, 흡착율이 좋아 환경에 존재하는 방사성 낙하물질을 검출하기 위한 

대표적인 환경시료로써 사용되고 있다. 그리고 이끼 및 지의류도 방사성 핵종을 

잘 흡수하는 특성을 가지고 있을 것으로 사료되는 시료들이다. 따라서 본 연구를 

통하여 동일한 지역에서 채취한 토양시료와 이끼시료의 방사능 농도 비교 함으

로써, 이끼시료의 환경방사능분석 시료로써의 효용성을 판단하고자 한다. 

오늘날에는 대기 및 수질오염과 같은 생활환경에 대한 국민의 관심 또한 높아

지고 있는 것과 더불어 방사능에 의한 환경오염에 대한 관심 또한 높아지고 있

다. 따라서, 비상시에 대비한 환경방사선의 베이스라인 data를 충분히 확보하는 

연구는 우리나라에서 직접적인 방사능 오염사고가 없더라도 인접국의 방사능 오

염사고 가능성에 대비할 수 있고, 국민들의 불안감 해소에 도움을 줄 것이다.  
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본 연구에서는 토양시료 및 이끼시료 중에 포함된 134Cs 및 137Cs의 방사능 농

도를 분석하기 위하여 시료채집 지역을 제주도 지역에 위치한 12개 지역을 선택

하였다. 시료의 채취는 2011년 11월 1부터 2012년 11월 15일까지 2주간이었다. 

채취된 각각의 시료는 실험실에서 전처리 과정을 거쳐 U-8용기에 충진한 후, 높

이와 무게를 확인하고 고순도게르마늄검출기(HPGe)를 이용하여 분석하였다. 또한 

134Cs 및 137Cs의 비를 계산하여 현재 존재하는 세슘의 기원을 확인하였다. 
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II. 이론적 배경 

 

 

1.  환경 방사능의 개요 

 

자연계에 존재하는 물질은 그 물질의 원자핵이 불안정해지면 스스로 안정화 

하려는 성질을 갖고 있다. 자연계의 많은 핵종을 보면 대체로 핵의 양성자 수와 

중성자 수가 같거나 비슷하다. 만약 핵이 양성자에 비해 중성자가 불필요하게 많

거나 역으로 부족하면, 그 핵은 불안정해지면서 에너지를 내보내고 안정하려 하

는데, 이때 내보내는 에너지가 곧 방사선이다. 즉, 방사선이란 에너지의 흐름이다. 

그리고 이렇게 불안정하여 방사선을 내보내려는 성질을 방사성이라 한다. 방사성

물질은 자연적 또는 인위적으로 발생하여 우리 환경에 존재하게 된다.  

우리가 살아가면서 받게 되는 방사선 피폭원에는 두가지가 있는데, 그 첫 번째

는 우주선(cosmic ray), 지각구성 방사성물질(우라늄, 토륨 및 그 붕괴생성물) 및 

인체구성 방사성물질 등의 자연방사선원에 의한 피폭이다. 인간이 환경과 더불어

서 살아가고 있기 때문에 자연방사선에 의한 피폭은 피할 수 없으며, 인류는 자

연방사선과 함께 생활하고 진화해가고 있다. 두 번째 피폭원은 치료와 진단 방사

선, 핵실험에 의한 낙진, 원자력 발전시설 등으로부터 누출되어 나오는 인공방사

선이다. 인류 문명이 발전함에 따라서 이러한 자연방사선과 인공방사선에 의한 

피폭이 증가하고 있기 때문에, 각종 방사성 핵종에 의한 환경오염 정도를 정확하

게 평가할 수 있어야 방사능에 의한 생물학적인 피해를 최대한 줄일 수 있을 것

이며 예상치 않게 일어날 수도 있는 핵사고를 준비할 수 있을 것이라고 생각한

다. 
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1.1 자연방사선원  

 

1) 지구기원 방사성 핵종 

지구가 생성될 무렵에 핵융합 활동에 의해 모든 종류의 방사성핵종이 생성되

었다. 지구가 생성된 후 냉각되어 가면서 45억년의 시간이 흐르는 동안 단 반감

기의 핵종은 점차 소멸하고 현재 남아있는 지구기원의 핵종은 반감기가 10억년 

이상의 것들과 이들의 붕괴 산물인 딸핵종들이다.  

자연방사성 핵종은 붕괴계열을 이루는 것과 그렇지 않은 것으로 나눌 수 있다. 

붕괴계열을 이루는 방사능은 모핵종에 따라 238U의 우라늄 계열(4n+2), 235U의 악

티늄 계열(4n+3) 및 232Th의 토륨 계열(4n+0)이 있으며, 241Pu의 넵튜니움 계열

(4n+1)은 이미 거의 붕괴소멸하고 209Bi 만이 존재한다. 이들은 Fig. 1의 238U 붕괴

계열도에서 보는 바와 같이 알파붕괴와 베타붕괴를 반복하며 안정원소 납으로 

변해간다. 이때 알파붕괴 시 질량수가 4씩 감소하므로 4의 배수와 나머지의 질량

수 변화로 나타낸다.  

238U은 가장 무거운 자연원소이며 붕괴산물일 234U와 함께 거의 방사평형을 이

루고 있다. 238U, 234U, 235U의 자연 존재비는 99.27%, 0.0057%, 0.72% 이다. 238U 붕괴

계열에서 딸핵종인 226Ra, 222Rn, 210Pb, 210Po 등이 대표적인 자연방사성핵종으로 존

재한다. 이중 라듐의 붕괴산물인 222Rn은 기체상으로 변함으로써 대기 중으로 방

출 이동할 수 있다. 지구기원 방사성핵종은 지각과 토양에 주로 존재하고, 일부

는 부유물 또는 가스상으로 방출되어 대기 중에 존재한다. 또한 이들은 빗물이나 

지하수에 용출 및 용해되어 지표수, 지하수 및 해수에 분포하게 된다. 자연방사

능은 자연 상태에 존재해 왔으므로 이에 의한 영향은 인간이 생활 하면서 피할 

수 없다. 그러나 근래 산업발전과 인간의 활동에 의해 자연 상태보다 높은 준위
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로 농축된 자연방사능(TENORM: Technically Enhanced NORM)에 대한 관심이 높아

지고 있다.  

 

 

Fig. 1.  Uranium decay series. Vertical and diagonal arrows represent α- and  β-

decay, respectively. 

 

 

 



 

16 

 

 

 

 

Fig. 2.  Thorium decay series. Vertical and diagonal arrows represent α- and  β-

decay, respectively. 
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Fig. 3.  Actinium decay series. Vertical and diagonal arrows represent α- and  β-

decay, respectively. 
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2) 우주선기원 방사성핵종 

고 에너지의 우주선이 지구의 외각으로부터 대기권으로 입사해 들어오고 있다. 

이 1차 우주선이 대기에 부딪쳐 대기 중의 물질과 작용하여 2차 우주선을 생성

하면서 방사성물질을 만들어낸다. 대기의 주성분인 질소와 산소가 파쇄(spallation)

될 때 14N(n, p)14C 등의 반응을 일으키며 생성되는 파쇄반응 생성물로는 14C, 7Be, 

3H 등을 들 수 있다. 우주선의 작용에 의하여 생성된 방사성핵종의 종류는 Table 

1에 나타내었다. 

 

Table 1.  Natural Radionuclide originated from cosmic ray 

Nuclide Half-life Nuclide Half-life 

3H 12.3 y 32P 14.3 d 

7Be 53 d 33P 25 d 

10Be 2.5x106 y 35P 8 d 

4C 5,730 y 38S 2.9 h 

22Ns 2.6 y 34mCl 32.0 m 

24Ns 15 h 36Cl 3.1x105 y 

28Mg 21.2 h 38Cl 37.3 m 

26Al 7.4x105 y 37Cl 55.5 m 

31Si 2.6 h 39Ar 270 y 

32Si 700 y 81Kr 2.1x105 y 

 

 

위 표에서 보는 바와 같이 우주선기원 핵종은 대부분 가벼운 원소들이며 반감기

는 32분(32mCl)에서 250만년에 이른다. 단 반감기의 핵종은 지상에 침적하여 생태

계에 들어가기 전에 소멸한다. 이들의 붕괴 및 침적 경로의 영향으로 지상의 고
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도에 따라 핵종 농도는 큰 폭으로 변한다. 또한 대류권과 성층권의 높이 변화 때

문에 위도에 따라 생성률도 달라진다. 14C과 3H 은 대표적인 우주선기원 핵종으로 

방사선 생태학적인 측면에서 중요하다. 7Be은 성층권과 대기권 상부에서 생성되

어 입자상으로 성장하면서 서서히 지표에 침착한다. 침착과정에서 대기 이동과 

확산의 영향을 받으므로 7Be 입자크기와 방사능량의 변동을 대기체류시간 추정 

추적자로 사용하기도 한다. 우주선기원 방사능은 지각에 침적하거나 빗물에 용해

되어 수권에 퍼져나가게 된다. 따라서 호수 등의 수리적 모델을 연구하는 데는 

22Na를 추적자로 사용할 수도 있다.  
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1.2 인공방사선원 

 

 1941년 12월에 착수한 맨하탄 프로젝트의 결과로 1945년 여름 3개의 원자탄

을 완성하였다. 1945년 7월 16일 미국의 뉴멕시코주 사막에서 첫 대기권 핵폭

발 실험이 성공하였으며, 이것이 인공방사능이 지구 규모로 확산하게 된 첫 사건

이다. 1945년 이래 지구상의 대기권 핵실험은 총 543회 시행되었다. 대기권 핵

실험은 1950년대 후반과 1960년대 초에 걸쳐 가장 빈번히 실시되었다.  이때 

생성된 방사성물질은 대기에 의한 수송, 확산으로 지표면에 강하되었다.  

핵의 연쇄반응에 의한 원자탄이 폭발하여 생긴 에너지의 50%는 폭풍으로, 

30%는 열로, 15%정도는 방사선에너지로 방출된다. 생성되는 방사성 핵종은 대

부분 핵분열반응에 의해 생성되며, 그 수는 200여종에 이른다. 이들 핵종중 환

경에서 검출될 정도의 수율을 가진 핵종은 질량수 72에서 161까지의 핵종들이

다. 그 중에서도 90Sr과 137Cs이 선량 추정 상 특히 주목되고 있는 핵종이며, 이

외에 주요 방사성 핵종으로는 3H, 14C, 55Fe, 85Kr, 239Pu, 240Pu 등이 있다.  

핵분열 생성물을 환경에 누출할 수 있는 시설로는 원자력발전소, 재처리시설, 

폐기물처분장 등이 있다. 우리나라는 재처리시설이 없고, 처분장도 건설단계에 

있으므로 현재 방사성물질을 배출하고 있는 주요 시설은 원자력발전소이다. 원자

력 발전소 등에서 생성되는 주용 방사성 핵종은 3H, 14C, 41Ar, 51Cr, 54Mn, 58Co, 

60Co, 89Sr, 85Kr, 95Zr-Nb, 103Ru-Rh, 106Ru, 131I, 133Xe, 134Cs, 137Cs, 141Ce 등

이다.  Fig 4는 137Cs의 붕괴 도식도를 나타내고, Fig 5는 세슘동위원소의 핵반응 

붕괴도를 나타낸다(Shigeo Ohki, 2002) 
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Fig. 4.  Decay scheme of 137Cs. 

 

 

 

Fig. 5.  Nuclear reaction chain for cesium isotopes. 
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1) 체르노빌사고 

1986년 4월 26일 체르노빌 원전 4호기의 저 출력 시험 중에 사고가 발생하

였다. 원자로의 불안정한 운전으로 통제가 불가능한 출력상승이 일어나 스팀계

통이 폭발하고 이어서 원자로 노심과 건물의 지붕이 날아갔다. 이후 파괴된 원

자로에서 10일간에 걸쳐 방사능이 누출되었다. 이 사고에서 대기 중에 방출된 

방사능량은 히로시마 원폭에 의한 것보다 400배 이상 많았다. Table 2에서 보

이는 것과 같이 일반인에게 가장 큰 영향을 주는 핵종인 131I와 137Cs의 방출량

은 각각 1,760 PBq, 85 PBq (1 PBq=1015  Bq)정도로 추산되었다.  

 

Table 2.  Radioactivity released during the Chernobyl nuclear accident 

Core inventory Total emissions 

Nuclides Half-life 
Radioactivity 

(PBq) 

Emission rate 

(%) 

Radioactivity 

(PBq) 

133Xe 5.3d 6500 100 650 

131I 8.0d 3200 50-60 ~1760 

134Cs 2.0d 180 20-40 ~54 

137Cs 30.0d 280 20-40 ~85 

89Sr 52.0d 2300 4-6 ~115 

90Sr 28.0y 200 4-6 ~10 

132Te 78.0h 2700 25-60 ~1150 

140Ba 12.8d 4800 4-6 ~240 

99Mo 67.0h 4800 >3.5 >168 
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사고 주변 3개 지역이 137Cs 농도가 37 kBq/m2 이상으로 오염지역으로 규정되

었다. 이들은 반경 500 km 내에 위치하고 면적으로는 150,000 km2이며 500만 

명의 인구가 거주하고 있었다. 사고 시 제한구역인 반경 30 km 내의 주민 

116,000명이 1개월 내에 소개되었고 원전마을인 Pripyat(인구수 45,000명)는 

완전히 폐쇄되었다. 

 

2) 후쿠시마사고 

2011년 3월 11일 오후 2시 16분 동일본 해안에서 동쪽으로 150 km 떨어

진 바다에서 리히터 규모 9.0의 대지진이 발생하였고, 이어 10미터가 넘는 쓰나

미가 동북부 일본 해안을 강타하였다. 이로 인하여 후쿠시마 제1 원전의 경수로 

4기의 원자로 냉각용 발전기가 작동되지 않아 원자로 내부에서 제어 불능의 핵

융합 반응이 일어나기 시작하였으며, 수소가스가 폭발하여 원자로 1, 3, 4호기

의 건물이 손상을 입었다. 이후 핵반응생성물이 외부로 방출되기 시작하여 원전 

주변뿐만 아니라 미국이나 유럽 및 아시아까지 퍼져나갔다.   

Table 3은 러시아에서 측정한 자료이고, Table 4는 이탈리아 밀라노에서 측정

한 자료들이다.  KINS에서 실시한 환경방사능 측정 결과를 보면, 134Cs과 137Cs 

핵종은 국내에는 2011년 3월 24일부터 춘천에서 측정되기 시작했으며 4월 5일

부터 국내 전 지역에서 측정되었다. 이때 공기부유진의 방사능 농도를 살펴보면 

각각 0.024~0.144 mBq/m3, 0.024~0.196 mBq/m3였다. 제주에서는 4월 6일부

터 검출되기 시작했으며 각각 1.05 mBq/m3, 1.86 mBq/m3 이었다.  또한 4월 6

일 18시부터 내린 비에 의해 공기 중에 있던 핵종들이 환경 및 토양 중에 유입

되었다. 다음 Table 5, 6, 7은 KINS에서 측정한 자료들이고, Fig. 6은 측정 장소

를 나타내었다.   
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Table 3. Fission product radionuclides in environmental samples collected at Krasnoyarsk 

(Russia) between April 4 and May 3, 2011 

Sampling area 
Sampled 

material 
date 134Cs 137Cs 134Cs/137Cs 

Kranoyarsk-1 Melted snow 2011/4/4 0.095±0.002 0.075±0.03 1.28 

Kranoyarsk-2 Melted snow 2011/4/4 0.031±0.00 0.037±0.004 0.84 

Kranoyarsk-1 Melted snow 2011/4/6 0.026±0.002 0.024±0.007 1.08 

Kranoyarsk-2 Melted snow 2011/4/6 0.048±0.004 0.055±0.003 0.86 

Kranoyarsk-1 Rain water 2011/4/28 0.005±0.001 0.007±0.003 0.71 

Kranoyarsk-2 Rain water 2011/4/27 <MDA <MDA - 

Kranoyarsk-2 Rain water 2011/5/3 0.006±0.002 <MDA - 

Kranoyarsk-1 Pine needles 2011/10/20 0.740.11 1.03±0.20 0.72 

 

 

Table 4. 134Cs and 137Cs concentrations in soil at Milano, Italy, following the 

Fukushima accident 

Sampling area date 134Cs 137Cs 134Cs/137Cs 

Segrate 2011/3/3 0.83±0.30 12.26±0.70 0.068 

Senago uncovered 2011/4/4 0.29±0.13 85.17±4.40 0.003 

Senago covered 2011/4/4 0.47±0.28 84.65±4.40 0.006 

Segrate 2011/4/6 0.48±0.27 18.73±1.02 0.026 

Segrate 2011/4/13 <0.21 18.65±1.04 - 

Segrate 2011/4/20 <0.19 19.081.05 - 

Segrate 2011/5/4 0.45±0.19 9.62±0.56 0.047 

Segrate 2011/5/11 <0.06 11.99±0.63 - 

Segrate 2011/5/18 <0.07 24.95±1.30 - 
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Fig.6.  Map of regional monitoring stations and posts in Korea. 
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Table 5.  Ranges of 134Cs and 137Cs concentrations in daily aerosol samples collected at 12 

regional monitoring stations in Korea during March 28 to May 31, 2011 

Place 134Cs(mBq/m3) 137Cs(mBq/m3) 134Cs/137Cs 

제주 0.04-0.54 0.04-0.55 0.87±0.03 

부산 0.04-1.19 0.04-1.25 0.96±0.02 

광주 0.04-0.41 0.03-0.42 0.99±0.04 

대구 0.04-0.25 0.06-0.27 1.00±0.04 

군산 0.06-0.36 0.08-0.45 1.00±0.03 

대전 0.04-0.14 0.06-0.13 1.01±0.04 

안동 0.04-0.15 0.05-0.15 0.91±0.07 

청주 0.04-0.23 0.05-0.20 0.92±0.04 

수원 0.04-0.23 0.05-0.22 0.88±0.04 

서울 0.03-0.15 0.04-0.17 0.97±0.04 

강릉 0.05-0.20 0.04-0.26 0.81±0.03 

춘천 0.04-0.16 0.02-0.20 0.92±0.04 

 

 

Table 6. Ranges of 134Cs concentrations in daily rainfall samples collected at stations in Korea 

Inflow rate (Bq/m2) 

Place 

Mar Apr May Jun Jul Aug Sep Oct Nov Dec 

Total 
Inflow 

rate 
(Bq/m2) 

 

서울 0.00 - 0.13 0.09 0.04 - - - - - 2.21 

강원 - 2.69 0.21 0.05 - - - - - - 2.95 

충남 - 0.33 0.15 - - - - - - - 2.48 

충북 - 0.55 0.17 0.05 - - - - - - 0.77 

전북 - 3.46 0.08 0.02 - - - - - - 3.56 

전남 - 2.44 0.43 0.18 0.45 0.10 0.20 - - - 3.81 

경북 - 1.27 0.11 0.04 0.14 0.05 - - - - 1.60 

부산 - 4.81 3.19 0.44 0.49 0.39 - 0.03 0.03 0.05 9.43 

제주 - 24.52 0.37 0.20 0.07 0.09 - - - - 25.2 

전국 0.00 2.44 0.56 0.10 0.14 0.07 0.03 0.00 0.00 0.01 3.35 
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Table 7.  Ranges of 137Cs concentrations in daily rainfall samples collected at stations in 

Korea 

Inflow rate (Bq/m2) 

Place 

Mar Apr May Jun Jul Aug Sep Oct Nov Dec 

Total 
Inflow 

rate 
(Bq/m2) 

 

서울 0.01 2.36 
.36 

0.17 0.13 0.07 - - - - - 2.74 

강원 - 0.38 0.29 0.06 - 0.03 0.03 - - - 3.79 

충남 - 2.86 0.19 0.05 - - - - - - 3.10 

충북 - 0.72 0.21 0.09 - - - - - - 1.02 

전북 - 4.19 0.10 - - - - - - - 4.29 

전남 - 2.92 0.52 0.27 0.57 0.14 0.17 - - - 4.59 

경북 - 0.87 0.32 - - - - - - - 1.19 

부산 - 10.64 3.96 0.53 0.58 0.51 0.07 0.04 0.03 0.07 116.4 

제주 - 28.69 0.44 0.28 0.08 0.11 - 0.02 - - 29.6 

전국 0.00 2.44 0.56 0.10 0.14 0.07 0.03 0.00 0.00 0.01 4.69 
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2. 방사성 핵종의 거동 

 

방사성 핵종들은 발생원으로부터 방출하여 대기권에 환산된 후 강수에 포착 되

거나, 방사성 강하물(fallout)로서 장기간에 걸쳐 지표면에 강하되어 환경 중에 

분포한다.  

 

2.1 방사능의 대기확산 

대기 중에서 우주선에 의해 생성되거나 또는 핵실험에 의해 생성된 방사능은 

지구 규모로 확산되어 침적되므로 지구상의 남극이나 북극 또는 심해에 이르기

까지 분포한다. 따라서 이렇게 확산된 방사성 핵종은 환경의 백그라운드준위

(background level)를 형성하고 있다. 방사능의 확산에 중요한 대류권은 지상 

평균 높이 11 km까지이며 고도에 따른 온도감소율이 6.5℃/km 정도이다. 대부

분의 기상현상이 일어나는 1~2 km까지를 행성경계층이라 한다. 성층권은 대류

권상층부 고도 약 11 km에서 50 km에 이르는 지역이다. 성층권에서는 고도에 

따라 온도가 상승하며 대기가 안정하고 상하운동이 없으므로 방사능이 유입되면 

수년간 남아 있게 된다. 대류권의 높이는 위도와 계절에 따라 9 km에서 17 km

까지 변한다. 대류권의 공기 순환 고리를 Hadley cell이라 하는데 이는 계절별 

또는 위도별로 변동한다. 이에 대류권 상부와 성층권 하부 사이에서 와류 확산이 

일어나면서 성층권 방사능이 대류권으로 섞여 들어와 지상에 침착하게 된다. 이 

현상은 봄철에 가장 활발하다. 이것이 봄철에 낙진 강하 량을 많이 관찰할 수 있

는 이유이다.   

원자력시설에서 정상 운전시 기체 방사능이 굴뚝이나 지표에서 방출되면 주변 

가까운 지역으로 확산되며 침적 범위는 수십 km 정도 내로 한정된다. 이때 방출
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되는 방사성물질의 확산이나 피폭선량 평가를 위해 취급하는 대기현상을 원자력 

기상이라 한다. 굴뚝 점 선원에서 풍하 방향으로 확산되어 가는 plume이 

Gaussian 분포형태를 보인다고 가정하면 이때 지상에서(Z=0)에서 방사능농도는 

아래와 같이 표현된다.  

 

 

X(x, y) = Q/(πσyσz U) ᆞexp[-(y2 /2σy
2 + h2/2σz

2)]          (1) 

 

 

위 식을 Gaussian plume 모델이라 한다. Q는 방출률 U는 평균 풍속이며 σy σz은 

확산계수로써 풍속과 pasquill의 안정도 계급으로부터 계산한다. 위 식은 가장 

간단한 형태의 식이므로 실제 적용 시에는 지형효과 미기상상태 등을 보정하여 

사용하게 된다. 일반적으로 원자력 시설에서는 Gaussian 확산모델을 기초로 작

성한 전산코드(ODCM: Off-site Dose Calculation Manual)를 사용하여 주민선

량을 평가한다.  
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2.2 방사능물질의 침적 

핵 실험이나 원자력시설로부터 대기 중으로 방출된 방사성물질은 기류를 타고 

확산되어 침적되거나, 강수와 함께 지표에 침적하여 대류권에서 제거된다. 방사

능이 강우에 의해 침적하는 것을 습침적(wet deposition)이라 하고 건조한 대기 상

태의 침적을 건침적(dry deposition)이라 한다.  

방사능의 침적속도는 습침적 속도와 건침적 속도를 합한 값이다. 침적속도는 방

사능의 물리화학적 형태와 기후조건에 영향을 받는다. 지상으로 떨어지는 방사능

은 식물체 표면에 흡착된다. 식물체 표면의 방사능은 흡수되어 가식부로 옮겨지

고 식품섭취와 함께 인체에 들어오게 된다. 지상으로 떨어지는 총 낙하량 중에서 

식물체 표면에 침적되는 분율을 차단계수(interception factor)라 한다. 이 차단계수

는 식품섭취 경로에 의한 방사능의 섭취량 평가에 중요한 인자이며, 건ᆞ습침적 

형태와 방사능의 물리화학적 특성 및 식생밀도에 함수이다. 식생밀도를 고려한 

차단계수는 Chamberlain의 식이 널리 사용된다. 

 

R = 1- exp(-μ Yt )                         (2) 

 

위 식에서 차단계수 R은 수확 시 지상부의 식생밀도 Yt의 함수로 나타냈다. 여

기서 상수 μ는 환경특성에 따라 2.3~3.3 사이의 값을 쓴다.  

 지표 또는 식물체위에 침적한 방사능은 재부유(resuspension)할 수 있다. 재부유 

물질은 낙진에 추가되어 대기 중 농도를 증가시키는 효과가 있다. 지상 핵실험이 

중단된 후 낙진량은 서서히 감소하여 거의 검출 하한선에 다다르고 있다. 현재 

대기 침적으로 검출되는 137Cs, 239Pu, 240Pu의 주 발생원의 하나는 침적 방사능의 

재부유라고 간주되고 있다.  
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2.3 육상에서의 거동 

지상에서 침적한 방사능은 토양 내에서 이동, 토양에서 농작물로 이행, 토양에

서 대수층으로 이동 등의 이동경로로 설명할 수 있다. 이러한 육상 이동경로는 

환경감시계획을 수립할 때 주요 고려사항이 된다. 토양입자에 강하게 결합하는 

핵종은 이동속도가 늦다. 137Cs, 239Pu, 240Pu 은 토양입자에 강하게 결합하는 것으로 

알려졌다. 몇 가지 핵종의 토양 내 존재형태는 Table 8에 보여주고 있다. 

 

 

Table  8.  Fraction of radionuclide added to the soil (%) 

Nuclides soluble exchangeable fixed 

90Sr 5~10 80~90 2~15 

137Cs <0.2 30~40 50~70 

106Ru 5~15 3~5 80~90 

91Y 0.5~1.5 2~5 >95 

144Ce 0.1~0.5 1~5 >95 

 

 

토양에 존재하는 핵종은 식물체로 흡수된다. 이를 전이라 하며 토양에서 식물체

로 옮겨가는 정도를 전이계수(transfer factor)라 한다. 핵종의 전이계수는 10-1~10-2

정도 수준이다. 석회(Ca), 칼리(K) 비료는 토양 중 경쟁이온 효과가 있으므로 90Sr

와 137Cs의 흡수율을 떨어뜨릴 수 있다. 

 

 

 

 



 

32 

 

2.4 환경감시 주요 대상 핵종 

환경에서 주 관심 대상 핵종은 핵실험 낙진과 원자력 시설 유출물 중 비교적 

반감기가 긴 것들이다. 각 환경매질에서 주요한 핵종은 아래 Table 9에서 설명하

였다. 

이 중에서 반감기가 짧은 것들은 현재 운영 중인 원자력시설 부근에서 검출될 

수 있다.  

 

Table 9.  Radionuclides that are detected in the environment 

Major Radionuclide 137Cs, 90Sr, 3H, 14C 

Air 131I, 134Cs, 137Cs, 3H 

Water 3H, 89Sr, 90Sr, 131I, 134Cs, 137Cs 

Soil 90Sr, 134Cs, 137Cs, 238Pu, 241Am, 242Am, 99Tc, 129I 

Milk 89Sr, 90Sr, 131I, 134Cs, 137Cs 

Vegetation 89Sr, 90Sr, 95Zr, 131I, 134Cs, 137Cs,  

 

 

원자력시설은 배출관리가 철저하므로 환경에 관심이 될만한 방사능의 누출이 

거의 없다. 시설에서 멀리 떨어진 지역의 환경에서 주요 검출 대상은 137Cs, 90Sr, 

3H, 14C 등 4종이며 Pu 동위원소도 반드시 검출된다. 이들은 핵실험 낙진이 지구

규모로 확산 침적한 결과이다. 한편 재처리 시설이나 폐기물 처분장에서는 Pu 동

위원소, 241Am 등 초우라늄(transuranic)원소와 장반감기 핵종인 99Tc, 129I이 주요 감

시핵종에 추가되어야 한다. 주요 핵종의 환경 베이스라인 준위는 137Cs은 ~80 

Bq/kg in dry soil , 90Sr은 ~15 Bq/kg in dry soil이다.  137Cs의 분포는 핵실험 낙진과 체

르노빌 사고에 의한 것으로 토양 입자에 강하게 결합하여 이동성이 적으므로 지
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표에 10 cm 깊이 이내에 대부분 분포하고 있다. 현재 국내 환경준위는 80 Bq/kg 

in dry soil 이나 유기물이 많이 축적된 깊은 숲속에서는 4배 이상 검출된다. 깊이

별 분포를 Fig. 7에서 보면 137Cs은 이동이 느려서 지표에 많이 분포하고 이에 비

하여 90Sr은 더 깊은 곳까지 이동하였음을 보여주고 있다.  

 

 

Fig. 7. The distribution of radioactivity in soil per depth (Prior to 1994 Halla 

Mountain). 
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3. 감마선과 HPGe 검출기와의 상호작용  

방사선 검출기의 동작은 측정해야 할 방사선과 검출기 자체의 검출매질이 어떤 

물리 화학적 상호작용을 하는가에 의존한다. 방사선이 그 물질과 어떻게 상호작

용을 하며 에너지를 잃어 가는 기본적인 과정을 충분히 파악해야 한다. 그 중 감

마선을 측정하는 방법은 물질과 검출기의 상호작용으로 생긴 고속전자를 검출하

는 간접적인 측정방법이 이용되고 있다. 원자핵에서 방출되는 감마선의 에너지는 

보통 0.1~10 MeV 사이의 값이다. 이 에너지 영역에서 일어나는 작용은 많지만 주

로 광전효과(photoelectric effect), 컴프턴산란(compton scattering) 및 전자쌍생성

(electron pair production)의 상호작용이 일어난다.  

 

3.1  광전효과 (photoelectric effect) 

에너지 E0인 감마선이 원자의 궤도전자에 흡수되어 에너지를 전달함으로써 궤

도전자가 이탈하여 광전자로 방출되는 현상이다. 따라서 광자(X선이나 감마선)

는 소멸되고 그 에너지를 전자가 가지게 된다. 궤도전자는 일정한 크기의 결합에

너지(Eb)를 가지므로 광전자는 에너지 Ee= (E0-Eb) keV를 갖는다. 광전자는 대부

분 K-각 전자가 밖으로 나가면서 만들어지게 되므로 K-각 궤도전자의 빈자리

는 다른 궤도의 높은 에너지를 가진 전자가 에너지를 방출하면서 채워지게 된다. 

이 과정에서 특성 X선이 나오거나 다른 궤도의 전자와 상호 작용하여 Auger전

자가 나오게 된다. 이 X선들은 거의 발생위치 주변에서 흡수되므로, 결국은 E0 

전체가 검출기 내에 전자 에너지형태로 흡수되는 셈이 된다. 그 결과로 검출 신

호는 E0에 비례하는 특정 크기의 펄스들을 낸다. 이 펄스들을 파고분석기로 계

측하면 특정 채널부근에 많은 계수가 관찰되어 이를 도시하면 피크가 형성한다. 

이 피크를 전에너지 흡수피크 또는 광전피크라고 부른다.  



 

35 

 

3.2  컴프턴 산란 (compton scattering) 

입사된 감마선이 자유전자나 결합력이 매우 약한 궤도전자와의 충돌로 입사 

감마선의 에너지(hv)의 일부를 전자에게 주어 전자를 원자 밖으로 튀어나가게 

하고 입사된 감마선은 에너지가 감소되어 산란감마선(hv´)으로 나타난다. 이때 

입사 감마선의 에너지를 받아 원자 밖으로 튀어나온 전자를 컴프턴 전자라 한다.  

에너지가 수백 keV 이상인 감마선의 경우에는 다중 상호작용에 의해 산란감마

선이 검출기내에서 광전효과를 일으키게 되며 광전 peak를 만드는 역할을 하고 

있다. 그러나 검출기의 주위는 차폐체로 차폐시켜 사용하므로 선원으로부터 나온 

감마선이 다시 차폐물질에 의해 컴프턴 산란이 일어나게 된다. 이 산란된 감마선

이 다시 검출기로 입사하게 되면 후방산란의 peak가 나타나게 된다. 에너지와 

운동량보존법칙을 연립하여 풀어서 산란각과 감마선광자의 에너지와 컴프턴전자

의 에너지 사이의 관계는 다음과 같다. 

 

Ec = Eγ-  

=  Eγ-                    (4) 

 

여기서 α는 Eγ/mec
2 이고, Eγ는 입사감마선의 에너지이며, θ는 입사감마선의 

방향과 산란 감마선의 방향이 이루는 각이다. 감마선 산란각에 따라 컴프턴 전자
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는 최소 0에서 최대 2αEγ/(1+2α)까지 연속적인 에너지 분포를 가진다. 

 

 

 

3.3 전자쌍생성 (electron pair production) 

전자쌍생성은 입사감마선이 검출기의 매질인 Ge의 원자핵 근처를 지날 때 강

한 Coulomb장으로 인해 입사감마선이 소멸되고 대신 전자와 양전자의 쌍이 생

성되는 과정이다. 입사감마선이 전자와 양전자를 생성하기 위해서는 에너지 보존

법칙에 따라 전자의 정지질량 에너지의 2배인 1.02 MeV 이상의 에너지를 필요

로 한다. 이때 운동량이 보존되기 때문에 원자핵도 되튐 되지만 원자핵의 질량이 

전자의 질량보다 훨씬 크기 때문에 그 운동에너지는 매우 작으며, 무시할 수 있

다. 양전자가 검출기 매질을 통과하면서 자신이 가지고 있는 모든 에너지를 잃게 

되면 인접한 자유전자와 결합하여 소멸되고, 0.511 MeV의 에너지를 갖는 2개의 

감마선을 발생시킨다. 이렇게 생성된 감마선을 양전자 소멸방사선(annihilation 

radiation)이라 한다. 스펙트럼 상에는 2개의 소멸광자가 상호작용을 하지 않고 

검출기 외부로 이탈하게 되면 double escape로 나타나고, 1개의 소멸광자가 광

전효과를 일으키고 다른 1개는 검출기 외부로 이탈하게 되면 single escape가 

되며, 2개의 소멸광자 모두가 검출기내에서 광전효과를 일으키게 되면 전 에너지 

흡수가 된다. 또한 검출기내에서 1개 혹은 2개의 소멸광자가 컴프턴 산란을 일

으키는 경우에는 연속분포로 나타난다. 감마선의 에너지가 아주 큰 경우 쌍생성

에 대한 단면적은 다음 식과 같다.  

                     (5) 
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 전자쌍을 생성하는데 요구되는 최소한의 에너지는 1.022 MeV 이므로 에너지

가 1.022 MeV 이상의 감마선에서는 중요성을 가진다. 또한 원자번호의 제곱에 

비례하므로 같은 에너지인 경우 원자번호가 높은 물질에 반응을 많이 가짐을 알 

수 있다.  

 

III. HPGe검출기를 이용한 감마분광 분석법 

 

1. 원리와 구성 

 

감마선을 검출하는데 흔히 사용되는 검출기로는 기체충전 검출기, 섬광 검출기, 

반도체 검출기 등이 있다. 방사선 검출기에 역 전압을 인가하면 캐리어(Carrier)

가 제거된 공핍층(Depletion layer)이 생기는데 이 공핍층이 방사선에 대한 감

지층의 역할을 한다. 공핍층에서의 전하의 발생과 수집에 기초하여 입사 감마선

이 공핍층 내에서 전리작용으로 가전대(Valence band)에서 전도대(Conduction 

band)로 전자가 전이되고 동시에 가전자대에는 양공(Hole)이 생긴다. 전자-양

공 1쌍을 만드는데 필요한 에너지는 게르마늄(Ge) 반도체인 경우 2.96 eV이고 

기체는 30 eV이다. 기체 전리함의 일반적인 전리 에너지에 비해 매우 낮은 전리

에너지를 가진 Ge반도체는 높은 전하 발생이 가능하고 통계적으로 우수한 분해

능을 가진다. 이 연구에서는 전리퍼텐셜이 낮은 반도체 검출기를 이용하였다. 반

도체 검출기에는 Ge(Li)검출기와 HPGe검출기가 있지만 이 실험에서는 불순물

의 농도가 높아 높은 bias 전압을 걸어줄 수 있으며, 상온에 두었다가 측정할 때

에만 액체질소로 냉각시켜 사용할 수 있는 ORTEC사의 HPGe검출기를 사용하

였다. 검출기의 직경은 58.5 mm 이고 길이는 52.7 mm이며 60Co의 1332.5 
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keV 감마선으로부터 3˝x3˝ NaI(Tl) 검출기에 대한 상대효율은 30%, 분해능

은 1.85 keV, 그리고 peak-to-compton 비는 60이다.  핵종분석용 스펙트럼은 

MCA(multichannel analyzer) Card로 측정하였으며, 스펙트럼 분석은 APTEC 

프로그램을 이용하였다.  Fig. 8과 10은 검출기의 신호처리 및 스펙트럼 수집 흐

름도를 나타낸다.  필요한 장비는 기본적으로 HPGe검출기, 전치증폭기(Pre 

amp), 주증폭기(Main Amp), ADC(Analog-to-Digital Converter), 다중파고분

석기(MCA), 고전압공급장치(HV Supply)이다. 검출기는 대개 전치증폭기(Pre 

amp)와 같이 일체형으로 결합되어 있다. 주증폭기, ADC, 고전압공급장치, MCA

는 일반적으로 NIM(Nuclear Instrumentation Modules)을 이용한다. 이들을 묶

어서 하나의 모듈로 제작한 것도 있으며, 이것을 USB로 PC에 연결하여 사용한

다. 이 경우 PC에 설치된 MAESTRO, Gamma Vision, APTEC 등과 같은 감마

선 분광 프로그램(Emulator)이 MCA 역할을 수행하며 에너지 분광한 결과는 

PC의 모니터 상에 표시된다. 검출기는 외부 방사선의 영향을 배제하기 위하여 

납 차폐용기에 넣어야 한다. HPGe 검출기는 극저온으로 냉각해야만 제 기능을 

발휘하므로 검출기에 연결된 구리 냉각 봉을 액체질소가 들어 있는 용기(LN 

Dewar)에 삽입하여 사용하기 전 최소한 2시간 동안 충분히 냉각(77K)을 시켜

야 한다. 검출기에 연결된 케이블은 고전압 케이블(HV cable), 출력신호 케이블, 

전치증폭기 전원 케이블 3개로 이루어져 있다. HPGe 검출기는 대개 약 4000 V 

정도의 인가전압을 필요로 하므로 고전압 케이블(HV cable)은 NIM의 고전압 

공급 모듈에 연결하고, 신호 케이블은 주 증폭기 모듈에 연결하고 전치증폭기 전

원케이블은 주 증폭기 모듈의 뒷면에 있는 해당 단자에 연결한다. 각 케이블은 

끝 모양이 다르기 때문에 혼동을 일으킬 염려가 없다. 주 증폭기는 전치증폭기에

서 출력되는 미약한 pulse신호를 선형적으로 증폭하며, 증폭된 pulse신호의 높
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이는 감마선의 에너지를 나타낸다. ADC는 주 증폭기 모듈에서 출력되는 pulse

를 높이에 따라 수치로 변환하는 역할을 한다. 수치화된 pulse는 다중파고분석

기(MCA)에 입력되어 각 수치에 해당하는 메모리에 저장된다. 감마선 분광 프로

그램에는 대개 핵종 Library가 포함되어 있어 각 에너지 피크에 해당하는 핵종

을 Library에서 찾아서 에너지 스펙트럼에 표시한다. 

 

 

Fig. 8. Flow chart of a signal processing and collection about HPGe detector. 
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Fig. 9. High purity germanium(HPGe) γ-ray spectroscopy system. 

 

Fig. 10. High purity germanium(HPGe) γ-ray spectroscopy system mimetic 

diagram. 



 

41 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. 표준시료 조제 및 효율교정 방법 

 

2.1 표준시료(교정선원) 

환경시료의 감마 방사능 분석에서 감마선 에너지는 약 50 keV에서 3 MeV 정도

의 감마 핵종을 분석대상으로 한다. 따라서, 표준시료는 100 keV에서 2 MeV 사이

에 감마선을 방출하는 109Cs, 57Co, 139Ce, 203Hg, 115Sn, 85Sr, 137Cs, 88Y, 60Co 감마 핵종이 

혼합되어 있는 감마 교정용 표준 용적선원 QCY44 (Amersham Co.)을 사용하였다. 

본 실험에서는 Table 10과 같이 표준선원을 사용하여 에너지 교정 및 peak 효율교

정을 수행하였다. 

 

Table 10.  Standard source (QCY44, Amersham) used for analysis of HPGe detector 

Nuclide Energy (keV) Yield Half-life (day) 
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109Cd 88.03 0.0363 462.6 

57Co 122.06 0.8560 271.79 

139Ce 165.86 0.7987 137.64 

203Hg 279.2 0.8148 46.595 

115Sn 391.7 0.6489 115.09 

85Sr 514.01 0.9840 64.849 

137Cs 661.66 0.8510 11012.7 

88Y 898.04 0.9400 106.63 

60Co 1173.24 0.9986 1924.2 

60Co 1332.5 0.9998 1924.2 

88Y 1836.06 0.9936 106.3 

 

 

 

 

2.2 표준시료 조제 

표준시료 조제는 감마 방출 핵종이 혼합된 표준 용적선원 QCY44를 1 M HCl 

용액으로 적당히 희석한 후, 이를 시료용기(diameter 50 mm, height 70 mm; Mizuho 

Chemical Co., Japan)에 무게를 달고 방사능 농도를 계산하였다. 환경시료의 경우 

높이를 일정하게 채우기가 곤란하기 때문에 효율 및 에너지 교정용 시료는 약 5 

mm 간격의 높이별로 1 M HCl 용액으로 2.5 mm에서 50 mm까지 11개의 표준 용

적선원을 제조하였다. 시료자체흡수(self-absorption effect)에 의한 영향에 대해 밀

도 보정을 하기 위하여 각각의 무게를 정확히 정량하였다. 

 

2.3 효율교정 

조제된 표준시료는 Table 10과 같은 특성을 가지는 HPGe검출기(GEM-30185, 

EG&G Ortec, USA)와 MCA(Model 92X, EG&G Ortec, USA)으로 구성된 감마분광계
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에서 각각 80,000초 동안 수행하였다. 계측된 스펙트럼은 효율과 에너지 교정식 

및 분해능을 갖도록 Aptec program(Aptec Co.)으로 감마선 에너지와 높이에 대한 

내삽적인 관계식을 구하여 2.5 mm에서 50 mm까지 1 mm 간격으로 효율과 에너지 

및 분해능을 갖는 교정 spectrum을 만들었다. 표준 용적선원 중에 포함되어 있는 

60Co와 88Y 핵종은 각각 1173.24 keV와 1332.5 keV 그리고 898.04 keV와 1836.06 

keV의 감마선을 방출하는 동시에 또 다른 감마선 2505.74 keV와 273401 keV을 방

출하는 동시합산효과(summing effect)를 나타내기 때문에 계측효율이 감소된다. 또

한 시료의 밀도는 시료의 물질과 감마선이 상호작용을 일으켜 시료의 자체흡수

효과(self-absorption effect)를 나타내기 때문에 표준선원과 시료의 겉보기 밀도가 

다를 경우 계측효율이 감소하는 경향이 있다. 따라서, 동시합산효과(summing 

effect)와 시료의 자체흡수효과(self-absorption effect)를 보정하였다.  

3.  스펙트럼 Data의 해석 

 

감마선 스펙트럼 data해석 방법은 목적이나 필요로 하는 정보의 종류, 스펙트

럼의 특성(피크의 분해능과 모양, 피크의 존재밀도, 통계적 요동 등) 및 해석수단

(계산기의 종류나 능력)등에 따라서 여러 가지 방법이 있기 때문에 일의적으로 

설명하기는 곤란하다. 



 

44 

 

 

Fig. 11. Flow chart of Data analysis. 

 

 

특히 해석수단에 의존하는 정도가 크고 스펙트럼 해석의 신속성, 정확성 및 신

뢰성을 요구하는 경우 컴퓨터 사용은 필연적이라 할 수 있다. 즉 4000개 정도의 

방대한 data(채널당 counts)를 처리하는 일에 있어서 MCA의 메모리로부터 컴퓨터

로 data 전송을 시작으로 각종 연산으로부터 해석결과를 기록하기 까지를 일관되

게 수행하는 data처리가 불가피하다. 따라서 오늘날 PC급의 컴퓨터를 통해 일관

되게 data처리를 할 수 있는 상용의 S/W들이 많이 보급 되어 있다. Fig 11은 감마
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선 스펙트럼 해석에 있어서 일반적인 data 해석의 흐름도이다. 이 흐름도는 사용

기기나 해석수단에 따라 상당한 차이가 있을 수 있다.  

 

3.1 스펙트럼 평활화 및 피크 검색(판별) 

 Ge검출기로 측정한 감마선 스펙트럼의 경우 일반적으로 피크 부분은 평탄한 

연속부(이하 baseline이라 함) 위에 있으며 통계적 요동이 더해져 있다. 이것을 전

기신호로 비유한다면 신호성분(피크), DC성분(baseline) 및 잡음성분(통계적 요동)

에 해당한다. 따라서 신호대 잡음의 비 (S/N비)를 개선하고 DC성분을 제거하여 

신호성분을 분석하는 것이 감마선 스펙트럼 해석의 목적이다. 그 제 1단계가 S/N

비의 개선, 즉 스펙트럼 평활화이다. 전기신호는 filter회로에 의해서 능동적으로 

할 수 있지만, 이산적인 data인 감마선 스펙트럼의 평활화는 수치 filter를 이용한 

연산처리를 통해 수행하여야 한다. 이와 같이 통계적 요동이 포함된 자료를 완만

하게 하는 통계적 잡음을 제거하는 방법으로 가장 간단하게는 어떤 특정의 채널

을 포함한 좌우의 구간내에서 평균값을 구하는 방법이다. 이때 각 점들이 동등하

게 평균값에 기여하는 평균을 단순이동평균이라 하고 이것은 단순히 산술적인 

평균을 의미하는 것이다.  

평활화 처리는 2번 이상을 하는 것이 좋으며, 주의할 것은 피크의 해석영역을 

그 정확도에 맞도록 넓혀서 정해야 한다는 점과 그 근방에 피크가 있을 때에는 

피크 중심이 shift하게 된다는 점이다. 

다음은 피크검색에 관해서 설명하고자 한다. 스펙트럼에서 피크를 컴퓨터로 판

별하는 방법은 어떤 판별의 기준을 설정해 두고 이것과 비교해서 유의 정도에 

따라서 결정하는 방법이다. 평활화는 S/N비 개선을 목적으로 일종의 적분 조작

(convolution)을 하는 것이고 피크의 검색방법은 반대로 스펙트럼 미분을 염두에 
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둔 방법을 기본으로 하고 있다. 스펙트럼의 baseline은 어떤 제한된 채널영역(반치

폭의 수배정도)에서 거의 직선에 가깝다고 생각할 수 있기 때문에 1차미분 또는 

2차미분을 함으로써 피크가 제거되는 것이 있다. 그러나 통계적 요동이 큰 스펙

트럼을 그대로 미분하면 요동이 더욱더 커지므로 평활화를 포함한 방법이 이용

되고 있다. 그 방법으로 이차미분방법을 들 수 있으며 앞에서 설명한 평활화와 

거의 동일한 수법이다. 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.2 피크중심 채널의 결정 

 피크중심 채널을 구하는 방법에는 여러 가지 방법이 있는데, 피크 폭, 피크 

대칭성, 계수의 통계적 요동 및 계산수단 등을 고려하여 적당한 방법을 선택한다. 

그래프상에 plot한 그림으로부터 대략적인 중심을 알 수 있지만 감각적 요구를 

배제하는 의미에서 여기에서는 계산에 의한 방법을 설명하고자 한다. 
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○1  1차 미분계수 Zero-Cross법 

 이 방법은 앞에서 설명한 스펙트럼 평활화나 피크 검색법의 수단과 비슷한 

것으로 피크의 1차 미분계수가 zero를 가로로 지나는 점을 피크 중심으로 하는 

방법이다. 

○2  지수함수로 변환하는 방법 

 피크의 중심부분은 Gauss함수로 근사할 수가 있으므로 이를 단순 지수함수로 

변환함으로써 피크의 중심채널을 구하는 방법이다. 이 외에도 피크의 무게중심을 

이용하는 방법, 피크 근방의 3점 계수치에 의한 방법 등이 있다. 

 

3.3 반치폭(FWHM)의 결정 

HPGe 검출기로 얻어진 감마선 스펙트럼은 보통 0.5 keV/ch 정도의 채널폭을 이

용하는데 이와 같은 경우에 피크를 형성하는 채널 수는 기껏해야 수 채널 정도

이다. 따라서 피크 부분의 data를 plot해서 FWHM을 구하는 것은 매우 어렵다. 그

러므로 피크의 중심부분을 Gauss함수로 가정해서 계산으로 구하는 방법이 이용

되고 있다. 이러한 방법으로는 함수 fitting법(비선형 최소자승법)및 지수함수로 변

환하는 방법 등이 적용되고 있다.  

 

 

3.4 피크 면적(Area)의 결정  

피크 면적은 피크의 순(net)계수치의 합으로써 이것을 가지고 방사능을 정량적

으로 결정한다. NaI 검출기로부터 얻어진 스펙트럼의 경우는 에너지 분해능이 상

대적으로 좋지 않기 때문에 baseline의 설정이 곤란하여 정확한 피크의 면적을 구

하기가 쉽지 않다. 이에 반해서 Ge검출기로부터 얻어진 감마선 스펙트럼의 경우

는 Baseline이 비교적 명확하게 설정할 수가 있기 때문에 피크 면적을 구하는 것
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이 비교적 용이하다.  

피크 면적을 구하는 방법으로는 크게 구분하면 채널들의 계수치를 합산하는 

계수치적산법과 함수 fitting법으로 나눌 수 있다. 전자는 독립적인 피크에 대해서

는 계산이 쉽기 때문에 신뢰성이 높지만 2개 이상의 피크가 근접하여 있거나 중

첩되면 해석이 곤란하다. 후자는 독립적인 피크에서 보다는 오히려 중첩된 피크

의 해석에 적합하지만 컴퓨터를 필요로 하고 계산시간이 길며(컴퓨터성능, 파라

미터 수 등에 관계됨), 해석 프로그램을 만들기가 쉽지 않다.  

 

○1  해석영역의 설정 

 계수치적산법, 함수 fitting법을 불문하고 피크 면적을 구하는 것에는 해석상 

모두 채널의 영역(피크영역과 baseline영역)을 결정하지 않으면 안 된다. 즉 함수 

fitting법에서는 피크영역과 baseline영역을 나누어 둘다를 포함한 해석영역을 결정

한다.  

  

○2  계수치적산법에 의한 피크면적의 결정 

 계수치적산법에 의한 피크면적을 구하는 방법은 계산이 간단하기 때문에 널

리 이용되고 있으나 주로 독립적인 단일의 피크에 대해서 유효하다. 그러나 중첩

피크에 대해서도 특별한 경우(피크가 동일 핵종에 의한 것, 또는 다른 독립적인 

피크가 기준 피크인 것)에 적용할 수 있다. 실제의 감마선 스펙트로메트리에 있

어서 대부분의 경우에 이 방법으로도 충분한데 특히 환경시료의 감마선 분석과 

같은 특정의 핵종만을 대상으로 하는 경우에는 오히려 이 방법이 가장 적당하다. 

계수치적산법에 있어서 피크 형태는 직접적으로 관계없지만 오히려 baseline의 

형태가 문제가 되는 경우가 많다. 그러나 해석영역이 그다지 넓지 않을 때에는 

baseline을 직선으로 취해도 거의 문제가 없다.  피크가 공교롭게도 컴프터 edge
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에 걸려있는 경우에는 직선의 baseline은 오차가 크게 되지만 이와 같은 경우는 

거의 희박하다. Baseline은 앞서 설명한 baseline영역의 계수치로 구하는데 일반적

으로 저에너지쪽과 고에너지쪽의 계수치가 계단으로 되어 있어서 이를 직선으로 

처리하거나 또는 2차식, 3차식 등의 다항식을 적용하여 처리하는 방법이 있다. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. 배경 스펙트럼 측정 및 보정 

 

검출기를 납 차폐용기에 넣고 시료 없이 에너지 스펙트럼을 측정한 경우에도 

다양한 에너지 피크가 나타난다. 이러한 배경스펙트럼은 검출기 주변의 자연 방

사성 핵종, 검출기 또는 차폐체에 들어있는 방사성 핵종, 계측 계통의 잡음 등에 

기인한다. 이러한 배경 스펙트럼은 시료를 측정하는 경우 중첩되어서 나타나므로 
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미리 측정하여서 시료를 측정한 스펙트럼에서 빼주어야 한다. 주의할 점은 시료

와 배경을 측정하는 시간을 같게 설정하여야 하며, 같은 기하학적 구조 및 특징

을 가지는 시료용기를 시료를 충진 하지 않은 상태에서 계측기에 두고 측정한다. 

대개의 감마선 분광 프로그램에는 배경 스펙트럼을 측정한 데이터를 저장해두고

서 보정하는 기능이 있으므로 이것을 이용하면 된다. 배경스펙트럼을 보정하는 

방법은 메인 화면에서 Analyze->Setup-> Background subtract (Shift+B)에 들어가서 

이전에 저장해 두었던 배경 스펙트럼을 불러오고, 피크 탐색 후 Analyze-> 

Background subtract (B)를 선택하면 된다. 

 

 

 

 

 

 

 

 

 

 

 

5. 최소검출방사능(MDA)의 정의 

 

방사선 계측시스템은 자연방사선 환경 속에서 운용되므로 필연적으로 

background의 영향을 받는다. 그런데 시료의 방사능이 극히 미미할 때는 그 신호

를 background와 구분하기 어려워지므로 측정할 수 있는 방사능의 한계 문제가 

발생한다. 실제로 얻은 계수가 background와 구분될 수 있는 한계를 검출한계치
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(Low Limit of Detection: LLD)라 부르고 이로부터 계수효율 등을 반영하여 방사능

으로 환산한 값을 최소검출방사능(Minimum Detectable Activity: MDA)이라 부른다. 

                       

(6) 

 

여기서 y는 붕괴 당 방사선 방출률, ε은 전계수효율, ts는 시료계측시간이다. 여

기서 보듯이 어떤 계측기 시스템으로 측정해 낼 수 있는 시료의 최소 방사능은 

계측기의 백그라운드 계수가 작고 계수효율이 크며 계수시간이 길어질수록 작아

진다.  

 

 

 

 

 

 

 

 

 

IV. 실험 재료 및 방법 

 

1. 채취지점 

본 연구에 사용된 토양 및 이끼 시료는 제주도 전역에 걸쳐 미 경작지 12개 



 

52 

 

지점을 선정하였고, 채취지점은 주변에 장해물이 없고 지면이 노출되어 있으며 

침식, 붕괴, 인위적 교란 및 식생 등의 영향이 적은 평탄한 곳을 선정하였다(Fig 

12, Table 11).  

 

 

Fig. 12. Distribution of the sampling locations in Jeju Island. 

 

 

 

 

 

Table 11. Geographical information of the sampling locations 

Location Geocode 
Altitude 

(m) 
Sampled date 

S1 
33 25.285 N 

126 33.248E 
569 2011-11-01 

S2 
33 25.384 N 

126 37.464 E 
605 2011-11-01 

S3 33 25.384 N  354 2011-11-11 
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126 37.464 E 

S4 
33 25.146N 

126 46.561E 
205 2011-11-01 

S5 
33 27.011 N 

126 46.027E 
251 2011-11-01 

S6 
33 17.980 N 

126 35.147 E 
245 2011-11-01 

S7 
33 19.265 N 

126 17.126 E 
166 2011-11-15 

S8 
33 26.121 N 

126 41.325 E 
407 2011-11-15 

S9 
33 27.385 N 

126 24.387 E 
122 2011-11-15 

S10 
33 15.792 N 

126 19.699 E 
116 2011-11-15 

S11 
33 23.457 N 

126 41.213 E 
423 2011-11-15 

S12 
33 22.226 N 

126 28.311 E 
1076 2011-11-15 

 

 

 

 

 

 

2. 채취 방법 

토양 시료는 일정한 면적(50x50 cm)의 지표면을 지정한 후 분해되지 않은 유기

물(나뭇가지, 낙엽 등)을 모두 제거하여 1 cm 깊이 이내의 표층토를 모삽으로 약 

2 kg 정도 채취하였다. 사전조사 결과 토심의 5 cm까지 채취하는 일반적인 토양 

채취법으로 채취할 경우, 134Cs 방사능 농도는 아주 극미량으로 검출 하한치 이하

로 측정되었기 때문에 최대한 표층토만을 채취하는 방식을 선택하였다. 이끼 시
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료는 토양을 채취한 지점으로부터 10 m 이내에서 돌 이나 암석 위에 자생하는 

것을 채취하였고, 채취한 이끼에 붙어있는 토양을 따로 분리하여 분석 시료로 사

용하였다. 그리고 토양 깊이에 따른 방사능 농도 분포를 측정하기 위한 토양 시

료는 2개 지점을 선정한 후 25 cm 깊이까지 채취할 수 있는 8개의 아크릴 재질

의 원통형 (직경 5 cm, 길이 25 cm) 채취기를 제작하여 채취하였다. 그리고 채취

한 시료는 잘 밀봉한 다음 연구실로 옮겨와 토심 5 cm 까지는 1 cm 단위로, 5 cm 

이후부터는 2.5 cm 단위로 분리하여 분석 시료로 사용하였다. 

 

Fig. 13.  Sampling of environment soil and mosses. 

 

3. 전처리 방법 

○1  시료는 신문지 등에 펼쳐 놓고서 돌덩이, 나뭇잎 등의 이물질을 제거하고 

골고루 섞은 다음 tray 에 넣고 건조 전 중량(FW: fresh weight)을 측정하였다. 
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Fig. 14.  Drying and weighing of samples. 

 

 

② 뭉쳐 있는 토양 시료 덩어리 들은 잘 부수어 주고, 105℃의 열풍건조기(dry 

oven)에서 약 24~48 시간 이상 건조시킨 후 상온에서 식히고 건조 중량(DW: dry 

weight)을 측정하였다. 여기서, FW 및 DW 를 측정하는 이유는 시료의 수분함량을 

구하여 토양의 inventory 을 계산하기 위한 것이다. 

 

③ 건조한 시료는 2 mm mesh 로 체치고 이때 통과한 시료를 건조 세토라 부르고 

이를 분석 시료로 하였다. 이때 2 mm mesh 로 치는 이유는 토양학적으로 2 

mm 를 통과한 것만을 토양으로 정의하기 때문이다. 

 

 

Fig. 15.  Separation of soil using a 2mm mesh. 

④ 2 mm mesh 를 통과한 건조 세토는 균일한 시료를 얻어 대표성을 확보하기 

위해서 분쇄기에 넣고 잘게 부순 후 넓은 tray 나 종이 위에 가능한 한 평평하게 

펼쳐놓았다. 그리고 우물정자 모양으로 9 등분하여 각 부분에서 일정량을 취한 

다음 혼합하여 감마핵종 분석 시료로 하였다.  
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Fig. 16.  Pulverized soil were put into a U8 container. 

 

 

⑤ 감마핵종분석을 위해 혼합된 토양시료는 U8 용기에 넣고 덮개를 닫아 

밀봉하고 시료 무게 및 시료 높이를 측정한 후 용기 뚜껑에 기록하였다. 여기서 

무게와 높이를 측정하는 이유는 이 과정을 통하여 시료의 밀도(g/cm3)를 구하여 

두면 최종 방사능 계산시 단위 환산이 가능하기 때문이다. (Bq/g ⇆ Bq/cm3)  

 

 

 

Fig. 17.  U8 container containing a soil sample. 

 

 

⑥ U8 용기에 넣고 밀봉된 시료는 HPGe 검출기 위에 얹어 놓고 감마선 분광을 

실시하였다. 검출기가 오염될 수 있으므로 검출기를 얇은 플라스틱 wrap 으로 

감싸주었고, 계측 시간은 80,000 초(22 시간)동안 측정하였다.  
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Fig. 18.  Is measured using a HPGe (Measuring time: 80,000 sec). 

 

 

이끼 시료의 전처리 경우도 토양 시료와 유사하였지만 채취 직후 이끼에 붙어

있는 토양들을 분리하였고, 남아있는 토양을 완전히 제거하기 위하여 물로 세척

하였으며 이를 이끼 토양 시료로 구분하여 추가로 방사능 분석을 수행하였다.  

 

 

 

 

 

 

 

 

4. 감마분광분석법에 의한 핵종 분석 절차 

 

감마분광분석법에 의한 핵종 분석은 우선, 절차가 까다로운 화학분리 등을 필

요로 하지 않으며, 또한 분석하고자 하는 시료를 곧바로 계측할 수가 있고, 시료 

내에 있는 방사성핵종들의 정성적인 식별과 동시에 정량이 가능하다. 그 외에 대
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부분의 핵분열생성물은 감마선이 방출되고 있기 때문에 감마분광분석법은 원자

력 관계시설로부터 방출되는 각종 방사성핵종 및 방사능 감시의 주요한 수단으

로 사용되고 있다. 따라서, 감마분광분석법은 환경방사능 측정분야에서의 품질관

리 수단이 되고 있다.  

감마분광분석법은 측정시스템을 교정하는 과정과 측정하고자 하는 시료를 채취

한 다음 전처리를 거쳐 측정한 후 분석하는 2가지 과정으로 나눌 수 있다.   

환경시료에 대한 감마선 스펙트럼의 분석은 계수치가 낮으며, peak의 모양이 찌

그러지고 방해 peak로 인해 분석하기가 매우 어렵다. 따라서 최종단계에서 분석

자의 경험적인 확인절차가 반드시 필요하다.  

분석용 시료는 시료의 수집과정으로부터 전처리과정을 거쳐 제조된 측정시료까

지의 각종 자료를 자세히 기록해 두었고, HPGe 검출기로 측정된 감마방사선 스

펙트럼은 방사성 핵종 분석에 널리 이용되고 있는 APTEC 프로그램을 사용하였

다. 그리고 핵종 판별에 이용된 library는 EML(Environmental Measurements 

Laboratory, USA)사에서 제작된 EML300. Lib를 활용하였다. 환경시료에 대한 

감마 핵종의 분석에 관한 과정은 Fig. 19와 같다. 
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Fig. 19.  Flow chart about γ-ray spectrometry method. 
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5. 감마핵종 분석 방법 

 

본 과정에서 스펙트럼 분석은 Aptec 프로그램을 이용 하였다. 메인 

화면에서 Sample Description (F5) -> Quantity Description (F6) 작업을 

완료하고, Analyze-> Setup -> ROI properties, Peak search, Multi fit, 

Identification 작업 순서로 진행한다. 그리고 Edit -> Load Header 

Information 을 선택 후 이전에 만들어 두었던 교정파일을 불러온다. 예를 들어 

U8 용기에 충진 된 환경시료의 높이가 35 mm 라면 높이 별로 저장해둔 교정 

파일에서 35 mm 에 해당하는 파일을 찾아 열기를 누른다. 그러면 Header 

Information 창이 열린다. 일반적으로 Effiency & Resolution Calibration 

정보만 선택하여 sample 시료에 적용한다. 이는 방사능 농도를 계산할 때 

효율을 적용하기 위한 것이다. 그리고 Analyze-> Setup -> Background 

subtract (Shift+B)에 들어가서 분석이 완료된 Background 파일을 선택한다. 

그 다음 Analyze-> Setup -> Quantify (Shift+Q)을 선택하여 단위를 

선택하여 주고, Activity Calculated 에서 방사능 농도 기준일을 설정해준다. 

일반적으로 시료 채취일을 입력해준다. 준비를 마치고 피크탐색 -> 에너지 

교정을 한다. 대부분의 Spectrum 은 232Th(63.3 keV), 226Ra(186.1 keV), 

212Pb(238.6 keV), Ann peak(511 keV), 40K(1460.8 keV), 208Tl(2614.4 

keV)와 같은 핵종들이 검출되기 때문에 이들을 이용하여 에너지 교정을 수행 

가능하다. 다음 핵종판별 과정에서 검색된 피크에 특정 핵종 작명하거나, 설정된 

Library 파일과 비교하여 핵종 부여한다. Analyze -> Background subtract 

(B)을 진행하면 Subtract 에서 설정된 파일들에 포함되어 있는 모든 값들을 

자동적으로 빼주는 과정이다.  Analyze -> Quantify (Q)순서로 진행하면 

Background Subtract, 효율 적용 등 모든 작업이 자동적으로 실행되어 최종 

방사능 농도가 계산된다. 이론적으로는 식 7 을 사용한다. 

 

                               (7) 

  

=감마선에너지 E 에서의 검출기 계수효율 
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Ap=피크의 면적 

Pγ=감마선 방출확률 

C= 측정선원의 자체 흡수, 동시합성, 방사성핵종의 붕괴시간 등에 대한 보정 

 

Pγ 은 문헌 또는 스펙트럼 분석 프로그램 내에 저장된 library data 로부터 

얻을 수 있다. 또한 보정 항 C 는 측정 시료의 물리 화학적 형태와 검출기를 

포함한 측정 장치의 특성 그리고 요구되는 측정 정확도에 따라 실험적 또는 

이론적 계산에 의해 구해질 수 있다. 그 다음 File -> Preview Spectrum 

Listing 에 들어가서 Geometry, 효율적용 파일의 일치 여부, 시료채취 시작일, 

계측 시작일 및 종료일, 시료 량, Library 및 Background 등이 모두 알맞게 

적용되었는지 확인한다. 

마지막으로 각 핵종별 방사능 농도, 오차, 검출하한치(MDA)를 확인해주면 

모든 작업은 완료했다고 볼 수 있다. 이때 측정된 방사능은 방출 시간으로부터 

시간이 지난 후 측정된 값이므로 반감기로 인하여 방사능이 감소한 값을 

보정해주기 위하여 식 8 을 사용하여 계산하였다.  

 

 

                           (8) 

 

 

여기서 A 는 현재 방사능, A0 는 초기방사능 λ는 붕괴상수, 그리고 t 는 

시간을 의미한다. 대부분의 핵종(137Cs, 60Co 등)들에 있어서 위의 감쇠보정식을 

적용하면 별 문제가 없지만 축차붕괴를 하는 핵종들(95Zr-95Nb, 140Ba-

140La 등)은 유의해야 한다. 왜냐하면 대부분의 상용의 분석 S/W 는 위의 방사능 

농도 계산 알고리즘에 의해서 감쇠보정을 하기 때문에 반감기가 짧은 핵종과 

축차붕괴를 하는 핵종의 경우 방사능농도가 크게 달라질 수 있다. 
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V. 결과 및 고찰 

 

1.  137Cs 분석 신뢰도 검증결과 

 

Table  12.  Analysis results of 137Cs for KINS reference materials 

Soil           Material 

Year 
Measured values Reference values Evaluation 

2011 99.8±1.90 100 ±3.0 A (acceptable) 

2012 86.8 ±1.66 83.0 ±2.60 A (acceptable) 

 

Table 12는 2011 - 2012년 사이에 KINS에서 제공하는 비교시료중의 137Cs의 분석 

결과를 나타내었다. 이들 값은 토양 시료의 감마 핵종 비교분석 평가기준인 원자

력위원회(IAEA)의 AQCS(Analytical Quality Control Service)의 평가방법에 따라 설정

된 기준값과 거의 일치하여, 본 실험의 분석 자료에 대한 신뢰도를 인증받았다

(KINS, 2011-2012). 
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2. 토양 시료 중 134Cs 및 137Cs 분석 결과 

Table  13.  Specific activities of 134Cs and 137Cs in surface soil samples 

Sampled 

locations 

134Cs 

(Bq kg-1–dry) 

137Cs 

(Bq kg-1–dry) 

Activity ratio 

134Cs/137Cs 

S1 11.96±0.62 62.56±1.53 0.19±0.01 

S2 16.73±0.72 26.84±1.09 0.62±0.04 

S3 6.38±0.47 108.62±2.1 0.06±0.004 

S4 <1.13 36.74±0.93 - 

S5 2.88±0.3 98.46±1.84 0.03±0.003 

S6 3.38±0.31 12.14±0.56 0.28±0.03 

S7 2.16±0.26 39.69±0.94 0.05±0.006 

S8 6.29±0.83 28.46±0.83 0.22±0.03 

S9 <1.04 17.50±0.58 - 

S10 2.87±0.27 53.62±1.15 0.05±0.005 

S11 13.90±0.72 78.87±1.87 0.13±0.01 

S12 5.47±0.63 58.95±1.65 0.13±0.01 

< : less than Minimum Detectable Activity( MDA) 

- : not calculation 

 

Table 13은 제주 지역의 토양 미 경작지 토양 중 134Cs 및 137Cs 방사능 농도와 

134Cs /137Cs ratio을 나타내었다. 134Cs 방사능 농도는 S2가 16.73 Bq/kg-dry로 가장 높

았고, S7이 2.16 Bq/kg-dry로 가장 낮았다. 그리고 S4와 S9의 경우 각각 0.934 

Bq/kg-dry, 0.561 Bq/kg-dry 아주 극미량으로 방사능 농도는 검출하한치 값이 각각 

1.13 Bq/kg-dry, 1.04 Bq/kg-dry보다 적게 검출되었다. 137Cs 방사능 농도는 S3이 

109.62  Bq/kg-dry로 가장 높았고, S6이 12.14 Bq/kg-dry로 가장 낮았다.  Fig. 20은  

134Cs 및 137Cs이 측정된 대표적인 감마 핵종 스펙트럼을 나타내었다. 
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a. 

 

 

b. 

 

Fig. 20.  Spectrum of (a) 137Cs and (b) 134Cs in surface soil samples. 
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3. 이끼 토양 중 134Cs 및 137Cs 분석 결과  

Table  14.  Specific activities of 134Cs and 137Cs in soil attached moss samples 

Sampled 

locations 

134Cs 

(Bq kg-1–dry) 

137Cs 

(Bq kg-1–dry) 

Activity ratio 

134Cs/137Cs 

S1 13.65±0.57 97.15± 1.99 0.14±0.01 

S2 30.67±1.14 46.56±1.63 0.66±0.03 

S3 19.54±1.08 79.97±2.31 0.24±0.02 

S5 12.46±0.72 20.26±1.06 0.62±0.05 

S6 9.28±0.56 26.94±0.97 0.34±0.02 

S7 8.27±0.43 127.20±2.53 0.07±0.003 

S8 29.09±1.35 30.61±1.68 0.95±0.07 

S9 2.61±0.21 4.40±0.34 0.59±0.07 

S10 7.66±0.34 39.35±0.94 0.19±0.01 

S11 27.28±0.99 106.64±2.55 0.26±0.01 

S12 12.91±0.67 36.62±1.19 0.40±0.02 

 

Table 14는 제주 지역의 이끼 토양 중 134Cs 및 137Cs 방사능 농도와 134Cs /137Cs 

ratio을 나타내었다. 134Cs 방사능 농도는 S2가 30.67 Bq/kg-dry로 가장 높았고, S9가 

2.61 Bq/kg-dry로 가장 낮았다. 137Cs 방사능 농도는 S7이 127.20 Bq/kg-dry로 가장 

높았고, S9가 4.40 Bq/kg-dry로 가장 낮았다. 이끼 토양 중 134Cs/137Cs ratio는 

0.14~0.95 범위였다. 

 

 

 

 

 



 

66 

 

4. 토양 중 깊이 별 134Cs 및 137Cs 분포 분석 

 

Table  15.  Depth profiles of 134Cs and 137Cs in the soil of location S3 

depth(cm) 

134Cs 

(Bq kg-1–dry) 

137Cs 

(Bq kg-1–dry) 

0 - 1 5.25±0.45 110.61±2.23 

1 - 2 2.92±0.42 120.92±2.41 

2 - 3 2.89±0.38 136.22±2.61 

3 - 4 - 158.47±2.97 

4 - 5 - 208.67±3.63 

5 - 7.5 - 254.80±4.22 

7.5 - 10 - 189.18±3.26 

10 - 12.5 - 87.33±1.78 

12.5 - 15 - 43.05±1.08 

15 - 17.5 - 15.56±0.63 

17.5 - 20 - 6.37±0.44 

20 - 22.5 - 3.32±0.36 

< : less than Minimum Detectable Activity( MDA) 

- :  N.D (not detectable) 

Table 15는 S3 조사 지점에서 토양 깊이에 따른 방사성 세슘의 분포를 확인하

기 위해 지표에서 25 cm 깊이까지 분석한 결과를 나타내었다.  Fig. 23의 (c)와 

Fig. 22의 (a)를 보면, 134Cs은 0~3 cm까지만 검출되고 있으며 반면 137Cs은 7.5 cm까

지 방사능 농도가 증가하는 양상을 보이다가 다시 감소하는 것을 볼 수 있었다. 

이러한 것은 체르노빌 원전사고나 핵실험 때의 137Cs이 존재하고 있음을 확인 할 

수 있었고, 핵종이 눈이나 비 등의 영향을 받아 점차 지표에서 밑으로 이동하고 

있는 것으로 보인다. 그리고 후쿠시마 원전사고로 인하여 표층토(약 ~3 cm)에 아
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주 극미량 영향을 받은 것으로 생각되어진다. 하지만 134Cs의 경우는 반감기가 짧

아 이전 사고들의 영향들은 현재까지 존재하지 않았기 때문에 후쿠시마 원전사

고의 영향으로 0-3 cm까지만 검출된 것으로 보인다.  
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Table  16.  Depth profiles of 134Cs and 137Cs in the soil of location S5 

depth(cm) 

134Cs 

(Bq kg-1–dry) 

137Cs 

(Bq kg-1–dry) 

0 - 1 2.99±0.34 151.02±2.72 

1 - 2 - 164.80±3.02 

2 - 3 - 162.55±2.97 

3 - 4 - 168.67±3.01 

4 - 5 - 142.35±2.61 

5 - 7.5 - 79.08±1.55 

7.5 - 10 - 32.55±0.91 

10 - 12.5 - 9.33±0.52 

12.5 - 15 - 3.36±0.42 

15 - 17.5 - 1.98±0.35 

17.5 - 20 - 1.26±0.37 

20 - 22.5 - 1.08±0.48 

22.5-25 - 2.69±0.59 

< : less than Minimum Detectable Activity( MDA) 

- :  N.D (not detectable) 

 

 Table 16는 S5 조사 지점에서 토양 깊이에 따른 방사성 세슘의 분포를 확인하

기 위해 지표에서 25 cm 깊이까지 분석한 결과를 나타내었다. Fig. 22의 (b)을 보

면 137Cs의 경우 4 cm까지 증가하다 다시 감소하는 경향을 보였고, Fig. 23의 (d)를 

보면 134Cs의 경우는 1 cm까지 에서만 검출되었는데, 이러한 것은 S3과 다른 경향

을 보이고 있었는데 S3 조사 지점의 강우량이 S5보다 더 많아 핵종의 이동이 조

금 더 활발히 일어난 것으로 보인다. 137Cs은 체르노빌 및 핵실험의 영향으로 현

재 핵종이 이동하고 있는 상황이고 표층토에는 후쿠시마의 영향이 더해진 것으

로 보인다. 134Cs의 경우는 후쿠시마의 영향을 받아 검출된 것으로 판단된다.  Fig. 
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21은 일본에서 측정한 토양 깊이에 따른 방사성 세슘의 농도를 나타낸 것이다.  

우리나라와 달리 직접적으로 유입된 방사능 량이 아주 많아 후쿠시마 원전사고 

이전의 영향이 아주 적어 표층토에서부터 점차 줄어드는 경향을 보이고 있었다. 

하지만 방사성 세슘의 분포 특성은 우리나라의 5 cm이하에서의 경향과 유사한 

것을 알 수 있었다. 따라서, 우리나라 토양의 0-5 cm까지는 후쿠시마 원전사고의 

영향을 받은 핵종이 거동하고 있어 일본과 달리 지속적으로 감소하는 경향이 아

닌 그래프로 나타나는 것으로 사료된다.   

 

 

 

Fig. 21.  Depth distribution of 137Cs and 134Cs activity concentrations in Kawamata 

Town, Japan. 
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Fig. 22.  Depth distribution of 137Cs activity concentrations in (a) S3 and (b) S5, Jeju. 
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Fig. 23.  Depth distribution of 134Cs activity concentrations in (c) S3 and (d) S5, Jeju. 
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5. 이끼 시료 중 134Cs 및 137Cs 분석 결과 

Table  17.  Specific activities of 134Cs and 137Cs in moss samples 

Sampled 

locations 

134Cs 

(Bq kg-1–dry) 

137Cs 

(Bq kg-1–dry) 

Activity ratio 

134Cs/137Cs 

S1 21.71±0.85 23.83±1.06 0.91±0.05 

S2 27.15±1.38 26.10±1.70 1.04±0.09 

S3 16.54±1.04 20.03±1.33 0.82±0.08 

S4 13.62±1.21 19.34±1.39 0.70±0.08 

S5 28.99±1.24 31.42±1.57 0.92±0.06 

S6 39.00±1.70 40.91±2.20 0.95±0.06 

S7 10.28±0.72 31.62±1.26 0.32±0.03 

S8 37.98±1.76 36.88±2.20 1.03±0.08 

S9 10.49±0.65 15.04±0.86 0.70±0.06 

S10 6.53±0.46 18.37±0.80 0.36±0.03 

S11 21.88±1.39 28.33±1.73 0.77±0.07 

S12 10.52±0.92 17.15±1.13 0.61±0.07 

 

이끼 시료에서 137Cs 방사능 농도는 Table 17에서 보는 바와 같이 S6에서 

40.91 Bq/kg-dry로 가장 높았고, S9에서 15.04 Bq/kg-dry로 가장 낮았다. 134Cs 

방사능 농도는 S6이 39.0 Bq/kg-dry로 가장 높았고, S10에서 6.53 Bq/kg-dry로 

가장 낮았다. 

여기서 후쿠시마 원전사고의 영향으로 판단되는 134Cs의 경우 동일한 지역에

서 채취한 토양 시료에 비해 상대적으로 채취량이 적었던 이끼 시료에서 방사능 

농도가 더 높게 조사되었고, 토양 중에서 검출하한치 이하로 조사된 지점에서도 

이끼 시료에서는 검출되는 것을 확인 할 수 있었다. 이러한 것은 방사능 세슘이

토양 중 흡착보다 이끼의 흡착 또는 흡수 정도가 더 높은 것으로 사료된다. 
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C.  

 

 

d. 

 

Fig. 24.  Spectrum of (c) 137Cs and (d) 134Cs in surface soil samples. 



 

74 

 

6.  토양 및 이끼 시료의 134Cs/137Cs ratio 

 

 

Fig. 25.  Distribution of the activity ratio 134Cs/137Cs in surface soil and moss 

samples. 

후쿠시마에서 방출된 134Cs/137Cs ratio와 본 연구를 통해 분석된 값들과 비

교함으로써 방사성 핵종들이 후쿠시마에서 기인하는 것임을 제시할 수 있다. 

Fig. 25를 보면 알 수 있듯이 134Cs/137Cs비가 토양이 0.03-0.62으로 나타났

는데, 이는 후쿠시마 사고에 의해 방출된 비 값으로 알려진 1에 비해 낮은 수

치이다. 즉 과거 체르노빌 원전사고 당시 방출된 137Cs이 현재까지 토양에 남

아 있는 것 때문으로 생각된다. 체르노빌 원전 사고 시 방출된 방출량은 134Cs

가 ~54 PBq, 137Cs이 ~85 PBq이었으며, 134Cs/ 137Cs ratio는 0.5~0.6였다. 

이끼 시료의 경우는 0.32~1.04로 나타나고 있는데, 토양에 비해 이끼 시료에

서 약 1에 근접하는 값들이 많이 나타났다. 결론적으로, 이끼의 경우 후쿠시마 

사고 이전의 영향이 미미한 것으로 보여지기 때문에 토양에 비해 방사선 비상 

사고 시 방사선 영향 평가에 있어 유용한 시료로 활용될 것이라 판단된다.  
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7. 후쿠시마 원전사고의 영향 분석 (토양) 

 

Table  18.  Estimation of Fukushima-originating 137Cs activity in surface soil 

Sampled 

locations 

Fukushima-originating 137Cs 

(Bq kg-1 –dry) 

Fraction 

(%) 

S1 13.1±1.0 20.9±1.7 

S2 16.1±4.8 59.9±18.0 

S3 7.9±1.0 7.3±0.9 

S4 1.7±0.5 4.6±1.4 

S5 3.1±0.4 3.1±0.4 

S6 3.6±0.4 29.8±3.6 

S7 6.9±1.1 17.4±2.8 

S8 6.1±0.9 21.4±3.2 

S9 <MDA - 

S10 8.0±1.1 14.9±2.0 

S11 18.1±1.9 22.9±2.5 

S12 9.0±1.4 15.3±2.4 

Average 7.8±1.7 18.1±5.6 

<  MDA : 최소검출 방사능 (Minimum Detectable Activity) 농도 이하 값 

 

현재 존재하는 137Cs 핵종은 이전 체르노빌 원전사고 및 핵실험 등에서 기인되

었을 뿐만 아니라 이번 후쿠시마 원전사고의 영향도 더해져 그 농도가 134Cs에 

비해 높게 나타나고 있다. 이끼 시료의 134Cs/137Cs ratio로부터 식 9를 이용하여 후

쿠시마 영향으로 토양에 유입된 137Cs을 계산한 결과 Table 18과 같이 나타내었다. 

S11에서 18.1 Bq/kg-dry 으로 가장 높았고, S9에서 검출하한치 이하로 나타났다.   

 = 이끼시료의               (9) 
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VI. 결  론 

 

본 연구는 고순도게르마늄(HPGe)검출기를 사용하여 제주지역의 토양 및 이

끼 시료를 채취하여 134Cs 및 137Cs을 측정한 것이다. 토양에 대한 방사능 농도를 

조사한 결과, 134Cs은 2.16 ~16.73 Bq/kg-dry로 검출되었고, 137Cs은 12.14 ~ 109.62 

Bq/kq-dry로 검출되었다. 전체 평균은 각각 51.87 Bq/kg-dry, 7.20 Bq/kg-dry이였다. 

이끼에 대한 농도를 조사한 결과, 134Cs은 6.53 ~ 39.0 Bq/kg-dry가 검출되었고, 137Cs

은 15.04 ~ 40.91 Bq/kq-dry가 검출되었다. 전체 평균은 각각 25.75 Bq/kg-dry, 20.39 

Bq/kg-dry이였다. 134Cs/137Cs ratio을 비교해 본 결과, 토양은 0.03 ~ 0.62, 이끼는 0.32 

~1.04로 나타났다. 토양에 비해 이끼의 ratio값이 후쿠시마 원전사고 당시 방출비

로 알려진 1에 근접하는 결과를 보이고 있었는데, 이는 토양에서 이전 체르노빌

원전 사고나 핵실험 등의 영향을 더 많이 받았기 때문으로 보여진다. 그리고 이

끼의 ratio가 방출비에 근접한 값들을 많이 보이는 것을 볼 때 이끼가 방사선 비

상 사고 시 방사선 영향 평가에 있어 유용한 시료로 활용될 것이라 판단된다.  

현재 제주지역 토양 중 137Cs 방사능 농도에서 후쿠시마 원전사고로부터 기인

한 137Cs을 분석한 결과 1.7 ~ 18.1 Bq/kg-dry으로 계산되었고, 전체 평균치는 7.8 

Bq/kg-dry로 나타났다. 토양의 깊이 별 세슘 농도를 확인하기 위하여 지표에서 25 

cm 깊이까지 분석한 결과, 137Cs은 약 5~7.5 cm까지 증가하다 다시 감소하는 양상

을 보였고, 134Cs은 1~3 cm까지 분포하고 있었다. 

본 연구 결과로부터 방사선 비상 시 극미량의 방사성 물질이 방출되어 환경 

에 유입되어 존재할 경우 방사선 영향 환경 평가에 있어서 토양 시료 채취방법

의 개선의 필요성과 이끼 시료가 방사능 지표 식물로써의 유용한 시료로 활용되

어 질 것이라 기대된다. 
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